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ELEN-0075-1 
Électronique analogique 

Notes de laboratoire 
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 Attention 
Il vous est demandé de vérifier, dès qu'il sera communiqué, si votre horaire de passage vous 
convient et d'éventuellement proposer des permutations en cas de conflit horaire et ce, au plus 
tard une semaine avant la date prévue pour votre labo. 

Il ne faut pas arriver à vos séances de laboratoire sans préparation. Un laboratoire doit 
être préparé pour être pleinement bénéfique. Vous trouverez la matière à revoir pour chaque 
labo au début des notes le concernant. 

Il est recommandé de 

·  lire préalablement les notes relatives au laboratoire que vous devez présenter. 

·  réfléchir à l’avance aux questions ne demandant pas de manipulations.  

Veuillez remettre un rapport de laboratoire pour chaque groupe à la fin de la séance. Ce 
rapport sera évalué et vous sera rendu peu avant la fin du quadrimestre. 

Notes préparatoires 
1 Règles et informations essentielles 

·  Les points attribués pour les laboratoires comptent à concurrence de 10% de la cote 
finale. Les points sont individuels et donc sont influencés par la participation. 

·  Un laboratoire facultatif (labo 0) de 2H est proposé à tous les étudiants suivants le 
cours avant le congé de Pâques. La participation y est vivement conseillée mais est 
laissée à votre appréciation. Aucun rapport ne sera ramassé ou évalué pour ce 
laboratoire. Vous pourrez vérifier vos conclusions auprès d’un étudiant moniteur 
présent lors de ces séances. 

·  Trois laboratoires obligatoires (labos 1 à 3) de 4H sont organisés pour tous les 
étudiants suivant le cours après le congé de Pâques. Un rapport sera remis par 
chaque groupe à la fin de la séance à l'étudiant moniteur présent. Ce rapport sera 
évalué sur base de la qualité des réponses et interprétations. 

·  Toute absence à l'heure et à la date prévue par l'horaire devra être justifiée par un 
certificat médical. Toute autre situation devra être exposée directement à M. 
Vanderheyden. Ce sera à vous de trouver une date pour représenter votre laboratoire. 
Toute absence non justifiée sera sanctionnée par un zéro à la cote du labo. 

 
 



C5CD���<�-�!�
�����
��
������*
��
�-�D��
��	
���>�� ���
�
�-�4�
� ����
����
 � ����,�
������  

 Présentation des locaux et du matériel  

1 Les laboratoires R100 et S125 

Le R100 Le S125 (local TFE) 

  
Le R100 se trouve à l’institut Montefiore (B28, P32) au rez-de-chaussée. L’accès se fait par 
le couloir reliant le hall d’entrée de l’institut et la passerelle menant à l’institut de 
mathématique. Le local se trouve entre le R75 et la passerelle. 6 tables de laboratoire y sont 
disponibles ainsi que 5 ordinateurs. 

Le S125, aussi connu sous le nom « local TFE », se trouve au sous-sol de l’institut 
Montefiore (B28, P32). L’accès se fait par le couloir reliant l’AEES à la sortie « sous-sol » 
donnant vers le B52. Le local se trouve à droite peu avant cette sortie. 4 tables de laboratoire 
y sont disponibles ainsi que 3 ordinateurs. 

Comme signalé dans le règlement d’ordre intérieur de ces locaux, la propreté, la tenue et le 
respect du matériel mis à votre disposition sont essentiels. 

Pour ce faire, des poubelles sont mises à votre disposition au pied de chaque table. Des 
poubelles spéciales « papiers » sont aussi présentes dans les deux locaux. Vous êtes donc 
invité à les utiliser. N’oubliez pas faire tomber dans ces poubelles tous vos petits déchets par 
exemple en balayant votre table à l’aide de votre main et d’une feuille de papier. 

Des poubelles au pied de chaque table 
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Des poubelles spécifiques pour le papier 

  

2 Le matériel à votre disposition 

2.1 Petit matériel 

Valisette contenant les câbles de connexion. 
Les valisettes s’ouvrent en glissant les curseurs vers l’extérieur. Vérifiez que le contenu 
de votre valisette correspond à la liste se trouvant dans la valisette et avertissez 
l’étudiant moniteur si la valisette est incomplète. 
 

  
 
Câble crocos, bananes 2mm pour EB2000 
et fils de connexions pour breadboard. Breadboard 

  

Selon les tailles et les différents modèles de breadboard, vous disposez soit de supports de 
connexion soit de bus de connexion. Le support de connexion est utilisé pour connecter des 
composants entre-eux. Vous aurez généralement de séries de deux lignes de 5 contacts 
interconnectés positionnés les uns au-dessus des autres comme représenté ci-dessous. 
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Les bus de connexion sont utilisés pour distribuer l'alimentation et le potentiel de masse à 
travers le circuit. Ils sont composés généralement de plus d'une vingtaine de contacts 
interconnectés tels que ci-dessous. 

 

2.2 EB-2000 

Station Station et carte PCB 

  

Vous aurez l’occasion d’utiliser des stations d’apprentissage EB-2000. Un mode d’emploi 
détaillé se trouve dans l’introduction des notes de laboratoire. Pour enficher une carte, il faut 
la poser sur la station, à un centimètre environ du connecteur et puis la connecter comme 
représenté. 

Les connexions sur la carte s’effectue à l’aide de câbles bananes de 2mm. Certains points des 
circuits sont déjà connectés aux alimentations souhaitées. 

2.3 Table de laboratoire 

La table Le bouton d’alimentation 

  
 

Les prises de courant des tables sont alimentées lorsque le bouton noir situé sur le montant 
gauche des tables est enfoncé. Sur certaines tables, sur le montant droit, un voyant lumineux 
s’éclaire lorsque la table est sous tension. 

Marche 

Arrêt 
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Pour utiliser un des appareils posés sur une table, il est nécessaire d’appuyer sur le 
bouton noir (marche). 

Veillez à couper l’alimentation en appuyant sur le bouton rouge avant de quitter le 
local. Attention, les multimètres doivent être éteints séparément, ils fonctionnent sur 
piles. 

2.4 Générateur multifonction 

 

Ce générateur multifonction est constitué de 4 appareils disctincts. 

·  Un compteur, permettant par exemple de déterminer la fréquence d’un signal. 
·  Un multimètre, permettant par exemple de mesurer des tensions et résistances. 
·  Une alimentation continue, permettant de générer des tensions continues. 
·  Un générateur de fonctions, permettant de générer des signaux carrés, triangulaires ou 

sinusoïdaux. 

Lorsque vous utiliserez l’appareil, vous constaterez qu’il y a deux boutons POWER. L’un est 
spécifique au multimètre et l’autre alimente les 3 autres appareils. Si l’appareil ne répond pas 
lorsque vous enclenchez ces boutons, vérifiez l’alimentation de la table et les interrupteurs 
situés à l’arrière du générateur multifonction. Veillez toujours à éteindre le multimètre après 
usage pour économiser sa pile. 

Le multimètre permet de mesurer des tensions et résistances selon le mode de fonctionnement 
choisi. Veillez dans le cadre de ces laboratoires à toujours mesurer des courants via les 
tensions mesurées aux bornes de résistances connues et l’expression I = V/R. Ne mesurez 
jamais les courants directement dans le cadre de ces laboratoires. 

 
L’alimentation continue dispose de trois séries de bornes de connexion. La première délivre 
5 V, la deuxième 15 V et la troisième est variable de 0 à 30V (varie à l’aide de boutons). 

Compteur Multimètre 
Éteindre séparément 

Générateur de 
fonctions 

Alimentation 
continue 

Interrupteur 
multimètre 

Interrupteur 
général 

Alimentation 5V 

Alimentation 15V 

Alimentation 0 - 30 V 



C5CD���<�-�!�
�����
��
������*
��
�-�D��
��	
���>�� ���
�
�-���
� ����
����
 � ����,�
������  

Le générateur de fonction permet de générer des signaux spécifiques, de fréquence et 
d’amplitude voulues. Attention, certains boutons n’agissent que s’ils sont tirés ou, dans la cas 
du variateur d’amplitude, lorsqu’il est tiré, les signaux générés sont de plus faibles 
amplitudes. 

 
Le compteur ne sera pas utilisé dans le cadre de ces laboratoires. 

2.5 Oscilloscope deux canaux 

TDS 2225 TDS 1002 

  
L’utilisation des fonctions classiques d’un oscilloscope est assez simple. Vous aurez 
l’occasion de manipuler des oscilloscopes 2 canaux, c’est-à-dire, permettant d’afficher deux 
signaux simultanément. Par exemple, l’oscilloscope pourra afficher un signal d’entrée et un 
signal de sortie d’un circuit simultanément sur son écran. Généralement vous vous servirez de 
sondes coax-crocos, dont vous brancherez la fiche coaxiale sur la borne de l’oscilloscope et 
les pinces crocos dans votre circuit. Notez que la pince crocodile noire correspond à la masse. 
Il vous est demandé de relier ensemble toutes vos masses (oscilloscope, alimentation, 
générateur, etc.) afin de garantir un potentiel de masse équivalent pour tous les appareils. 

Vous avez 3 modes d’affichage pour un canal : ground (masse) affichant le potentiel de 
référence sur le canal, AC (alternatif) supprimant la composante continue d’un signal, et DC 
(continu) affichant tout le signal (continu + alternatif). Généralement, vous utiliserez ground 
pour aligner (à l’aide du bouton position) vos canaux sur le même niveau de référence et 
visualiserez vos signaux sur DC. Sur les anciens appareils, cette sélection s’opère à l’aide 
d’un interrupteur 3 positions et sur les nouveaux appareils, vous devez vous servir d’un menu 
(channel menu). 

Le bouton rotatif situé au-dessus de la borne de connexion du canal modifie l’échelle 
d’affichage du signal (par exemple : 1 mV, 0,1 V, 5V par carré), généralement, l’échelle 
choisie pour le canal s’affiche sur l’écran de l’oscilloscope. Le troisième gros bouton rotatif 
agit sur l’échelle de temps (par exemple : 1ns, 1ms, 1s par carré). Vous devrez ajuster la 
position de ces boutons pour voir apparaître votre signal correctement. 

Modifie la fréquence 
des signaux délivrés 

Modifie l’amplitude 
des signaux délivrés 

Modifie le type de signal 

Sortie du signal (output) 

Modifie le niveau moyen 
des signaux délivrés (offset) 
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Notez qu’il existe sur certains modèles un bouton « autoset » laissant à l’oscilloscope le soin 
de rechercher, pour vous, le meilleur mode d’affichage pour les signaux qu’il reçoit. Ce 
bouton est à utiliser avec une grande vigilance car il conduira généralement à un affichage des 
signaux en mode AC rendant invisible la composant continue du signal. 

Un manuel détaillé du Tektronix TDS1002 se trouve sur le site : http://www.tek.com/. 

2.6 Ordinateur 

 
 

Sous Windows XP, ces machines disposent du logiciel PSPICE. Aucun logiciel ne peut y être 
installé sans autorisation. La modification des paramètres (écran de veille, etc.) de ces 
machines est formellement interdite. N’oubliez pas d’éteindre ces machines après usage. 

2.7 Divers (sur certaines tables) 

Multimètre (Éteindre séparément) Alimentation continue 

  

Générateur de fonctions  
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 LABORATOIRE 0 (Facultatif) 

1 Matière à revoir 

·  Fonctionnement de diodes et diodes zener (Cours, chap. 2 ; répétitions 1,2 et 3) 

2 Équipement nécessaire 

·  Un oscilloscope double trace 
·  Un multimètre 
·  Un générateur de signaux 
·  Breadboard 
·  Boîtes contenant les diodes, capacités et résistances prévues pour ce laboratoire. 

3 Visualiser des signaux à l’aide de l’oscilloscope 

La première manipulation consistera à visualiser un signal produit par le générateur de 
fonctions à l’aide de l’oscilloscope. 
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La sortie TTL d’un générateur de fonction délivre un signal carré d’amplitude (niveaux 0 et 
5V), de fréquence variable. Ce signal peut servir de signal de synchronisation (ou de signal 
d’horloge) pour tous les composants de type TTL largement utilisés en électronique. 

��  �������	
'
������

��
���
��
��
��

��
������
���
� �
����
����
��
�����

�
��
���������������
�����	
��
������
���
���
���
� ��������
��
�
��5�

/��������	
���
��
������
���
��
������

����������� �
!������	
���
��

"��
��
�����

��

"���
�������
�

�������	
�������
 ���
��
������
6�����'

�"
����
��
������
�7��

���
�����
���
��
#!�
!����� �	
'
������
��
����

������
���
*�
��
������
��

"���
���
��
���
������� ����
��
���������������


��  ����	
��
"��
��
�����

��
������
����
0��
��
�����1 
1��
2
������	

�*��
��������

��
"��
��
����
*���
������8
��
��
�� �����
�
����
���

��

"��
��
2


Commentaires : 
 
 

6� +����	
��
����
�/
���
���������������
/�����	
��
*� ����
�������
�

0���"���*�	1*���
2


Commentaires : 
 
 

��  ��*���	
��
����
./
���
���������������
/�����	
��
� ����
������
���
��

������
���
�

�"���*�	�
���

�������
��
���
���
��� �����
��
������
��

������
������������
1�����
��
��1�����
2


Commentaires : 
 
 



C5CD���<�-�!�
�����
��
������*
��
�-�D��
��	
���>�� ���
�
�-�@@�
� ����
����
 � ����,�
������  

��  9���
��������
���
�����)
���
��
��������������
��
� �
������
���:
'
������

����
�("��
��� 1������
�

����
�
,����
�("���
��� � �� -:
������
�	

����
����
:
��
������)��:
��������������
�

���
��� ��
����
;<$
����
,��

������
��
��

�
*�����-�
0���"���*�	1*���
��
������ ��

���

�������
'

*���
�

��
������
,�������
��
�����
����
��

������ 
��
-2


 
Commentaires : 
 
 

4 Mesurer c’est perturber 

Note sur la mesure en différence de potentiel en électronique analogique. 

N’ayant à disposition qu’une carte EB-111, chaque groupe réalisera tour à tour cette 
manipulation. Vous pouvez passer aux manipulations suivantes en attendant votre tour. 
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La manipulation suivante à pour but de mettre en évidence un problème de mesure affectant 
les multimètres digitaux employés. 

  
Alimentez le montage en émetteur commun de la Fig. 1 avec une tension PS-1 de 10 V. Au 
moyen de la résistance variable RV3, ajustez le point de repos du transistor à VCE = 5 V. 
Vous allez à présent mesurer la chute de tension aux bornes de la résistance de base R13 de 
trois façons différentes :  
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Q4 

PS-1 

R15 R14 RV3 

R11 

R13 

R12 

R16 

C1 

C2 

E 

C 
B 

 
Figure 1 
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Le problème observé est lié, dans le cas présent, au faible courant traversant R13, à la station 
EB-2000 et à la carte qui lui est connectée. En fait, le circuit que vous avez analysé est 
beaucoup plus complexe que le circuit dessiné sur la figure ci-dessus afin, dans un but 
d’enseignement, de pouvoir utiliser cette carte dans un mode permettant de pouvoir générer 
des pannes que les futurs ingénieurs et techniciens devraient détecter. Il apparaît que ce 
circuit « caché » perturbe la mesure des faibles courants. Vous l’aurez d’ailleurs constaté en 
mesurant la tension de collecteur, le courant de base est altéré par la présence du multimètre. 

En fait, si vous reproduisiez le circuit de la figure 1 sur une breadboard, la prise de mesure ne 
demanderait pas tant de prudence. En reproduisant les étapes c et d, aucune différence 
significative ne pourrait être observée. 

Quoi qu’il en soit, cette manipulation vous montre que la mesure différentielle d'une chute de 
tension (méthodes 1 et 2) est dangereuse ("Mesurer, c'est perturber") lorsque l’on ne connaît 
pas parfaitement les circuits que l’on analyse. Pour les multimètres employés au dans le cadre 
de ces laboratoires, seule la mesure individuelle des tensions à chaque point fournit un 
résultat fiable lorsque de faibles courants sont concernés. 

A tout moment, lorsque vous effectuez des mesures, il faut impérativement que vous restiez 
critique par rapport à votre système et par rapport aux résultats observés. Une comparaison 
avec un résultat théorique, même approximatif, pourra déjà vous aider à déterminer la fiabilité 
d’une mesure. 

5 Le pont diviseur 
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Attention, pour une mesure fiable de la valeur d’une résistance à l’aide d’un multimètre, il 
faut utiliser le multimètre dans le mode Ohmmètre (bouton rotatif sur la position « Ohms ») et 
extraire la résistance du circuit auquel elle est connectée. La lecture du code couleur des 
résistances est expliquée en annexe. 
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6 Le diviseur de courant 
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7 Le circuit redresseur 
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8 Le circuit limiteur 
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9 Circuits de fixation de niveau (« clampers ») 

Les « clampers » sont des circuits très simples utilisés afin de fixer la tension maximale ou 
minimale à une valeur donnée tout en gardant sa forme originale du signal. Les clampers sont 
par exemple employés pour modifier la composante DC d’un signal. 
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 LABORATOIRE I  

1 Matière à revoir 

·  Fonctionnement des diodes à jonction pn et diodes Zener (Cours, chap. 2 ; répétitions 
1,2 et 3) 

·  Le transistor bipolaire (Cours, chap. 3 ; répétitions 4 et 5) 

2 Équipement nécessaire 

·  Une station EB – 2000 
·  Le circuit imprimé contenant les 4 montages à tester 
·  Un oscilloscope double trace 
·  Un multimètre 
·  Un générateur de signaux 
·  Remarques : R1 = 220 W, R2 = 100kW, R3 = 1kW, R4 = 22kW, R5 = 470W, R6 = 

150W, R7 = 100W, R10 = 10kW, RV1 = 0 - 470kW, RV2 = 0 - 700W. 

3 Le redresseur simple alternance 

·  Repérez le montage redresseur (figure 1.1) sur le circuit imprimé :  

D2 

R3 Vin 

 
Figure 1. 1 : R3 = 1 kWWWW 

·  A l’aide du générateur de signaux, alimentez le circuit avec une sinusoïde de 4V crête 
à crête, 200 Hz. Placez la tension d’offset à zéro. 

·  Connectez le canal 1 de l’oscilloscope à Vin et le canal 2 aux bornes de la charge R3. 
Les 2 canaux doivent être dans le mode DC. 
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Vin, VR3 
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Figure 1. 2 
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Figure 1. 3 
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Vin, VR3
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Figure 1. 4 

Vin, VR3

t

1

2

-1

-2

 
Figure 1. 5 

2. Régulation de tension avec diodes Zener 

3.2 Caractéristiques de la Zener 

·  Repérez le montage suivant sur le circuit imprimé et connectez-le suivant la figure 1.6 
(PS-1 est l’alimentation continue de la station EB-2000 ou une alimentation 
indépendante). 

PS-1 

R6 R7 

RV2 

D3 

Vz 
+ 

 
Figure 1.6 : R6 = 150 W W W W et R7 = 100 WWWW 
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PS-1(V) 0 2 4 5 6 7 8 9 10 

Vz(V)          

Iz (mA) 
calculé          

Tableau 1.1 
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Vz (V)
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Figure 1. 7 
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3.3 Régulation de charge 

·  Ajustez la résistance R = (RV2 + R7) à 800 W et connectez R7 à la diode. 
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Vin (V) 5 6 7 8 9 10 12 

Vz(R=800W) (V)        

Vz(R=500W) (V)        

Vz(R=200W) (V)        

Vz(R=100W) (V)        

Régulation (V/mA)        

Tableau 1. 2 
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Vin (V) 

Régulation (V/mA) 

Vin (V) 

Vout (V) 

 

Figure 1. 8 
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Figure 1. 9 

Vin, VZ (R = 100 W)
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Figure 1. 10 

Vin, VZ (R = 800 W)
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Figure 1. 11 

Commentaires : 
 
 



C5CD���<�-�!�
�����
��
������*
��
�-�D��
��	
���>�� ���
�
�-����
� ����
����
 � ����,�
������  

4 Le transistor bipolaire 

4.1 Caractéristiques de base 

·  Repérez le montage du transistor bipolaire sur le circuit imprimé : 

 

R5 

R4 

Q1 

PS-1 
+ 

RV1 

5 V 

 
Figure 1. 12 : RV1 : 0 -> 470 kW , W , W , W , R4 = 22 kW , W , W , W , R5 = 470 WWWW 

·  Ajustez RV1 pour obtenir des courants IB appartenant aux intervalles donnés dans le 
tableau 1.3. Mesurez le courant IB réellement imposé via la tension aux bornes de R4. 
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IB (mA) désiré 5 - 15 16 - 25 25-50 80 - 120 

VR4 (V)     

IB (mA) réel     

VBE (V)     

Tableau 1. 3 
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I B  ( m A) 

V BE  (V) 
0.1     0.2 0.3 0.4 0.5 0.6 0.7 

30 
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120 
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90 

 
Figure 1. 13 
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4.2 Transistor comme source de courant 

·  Connectez le circuit figure 1.12 de la manière suivante : 
R5

R4

Q1

PS-1
+

RV1

5 V

 
Figure 1. 14 

 
·  Ajustez PS-1 à 2 volts et RV1 de manière à obtenir un courant de collecteur de 2 mA. 
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PS-1 1 2 4 6 8 10 

VR5 (V)       

IC (mA)       

Tableau 1. 4 

Commentaires : 

4.3 Caractéristiques de sortie 

·  En utilisant le même montage que précédemment, modifiez RV1 pour obtenir un 
courant de base de 15 mA (vérifier cette valeur au moyen de R4). 
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IB (mA)  15 20 40 80 100 
VCE (V) IC (mA) 

0,3 
VR5 (V) 
IC (mA) 

     

0,5 
VR5 (V) 
IC (mA) 

     

1 
VR5 (V) 
IC (mA) 

     

4 
VR5 (V) 
IC (mA) 

     

7 
VR5 (V) 
IC (mA) 

     

9 
VR5 (V) 
IC (mA) 

     

Tableau 1. 5 
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VCE (V)
1    2 3 4 5 6 7

IC (mA)

5

10

15

20

8 9 10  
Figure 1. 15 
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5 Caractéristiques de la diode à jonction 

·  Localisez, sur le circuit imprimé, le montage suivant.  

R1 R2

PS-1 PS-2
+

+

D1

 
Figure 1. 16 

R1 = 220 W et R2 = 100 kW 

5.1 Polarisation directe 

·  Ajustez l’alimentation PS-1 jusqu’à ce que la tension directe aux bornes de la diode 
soit égale à 0,2V. Mesurez le courant dans le circuit (au moyen du voltmètre en 
mesurant VR1). 
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VD1 (V) 0 0,2 0,4 0,5 0,55 0,6 0,64 0,67 0,7 
VR1 (V)          

If  (mA)          

Tableau 1. 6 
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Figure 1. 17 
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I
V

D
D

==
f

D1

I de Variation
V de Variation

  dynamique Résistance  

......
45.01

=
= VDVDR  

......
5.01

=
= VDVDR  

5.2 Polarisation inverse 

·  Connectez la diode en inverse (figure 1.18). 

R1 R2

PS-1 PS-2
+

+

D1

IR

 
Figure 1. 18 
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PS-2 (V) 0 -1 -5 -10 
VR2  (mV)     

IR2  (mA)     

Tableau 1. 7 

Commentaires : 
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 LABORATOIRE II 

1 Matière à revoir 

·  Amplificateurs à faibles signaux (polarisation, amplification) (Cours, chaps 4 et 5, 
répétition 4 et 5) 

2 Équipement nécessaire 

·  Une station EB-2000, le PCB EB-111 ou le circuit imprimé ou la breadboard 
contenant les montages à tester 

·  Un oscilloscope double trace, un multimètre, un générateur de signaux 
·  Remarques : R8 = 100W, R9 = 22kW, R10 = 1kW, R11 = 47kW, R12 = 10kW, R13 

= 22kW,R14 = 4.7kW, R15 = 680W, R16 = 1kW, R17 = 100W, RV3 = 0-43kW. 

3 Initialisation 

·  Placez le PCB EB-111 sur le Master Board et mettez ce dernier sous tension. 
·  Initialisez le microprocesseur (815, *, 017,*, *, *, *, *) et sélectionnez le mode 

EXPERIMENTS (1,*). 

4  Amplificateur à transistor bipolaire 

4.1 Fonctionnement en courant continu (polarisation) 

·  Localisez le circuit de la figure 2.1 et effectuez les connexions demandées. 

Q4

PS-1

R15R14RV3

R11

R13

R12

R16

C1

C2

 
Figure 2. 2 
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·  Réglez PS-1 à 10 volts et ajuster RV3 pour obtenir VCE = 5 volts. 
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4.2 Fonctionnement en courant alternatif (amplification) 

·  Avant de connecter le signal d’entrée, placez le point de fonctionnement du circuit au 
milieu de la droite de charge en ajustant VCE à 5 volts (à l’aide de RV3). 

·  Réglez le générateur de signaux pour qu’il délivre un signal sinusoïdal de 2 kHz et 
connectez l’oscilloscope de manière à visualiser vin et vout. 

·  Ajustez, ensuite, l’amplitude du signal délivré par le générateur pour obtenir à la 
sortie une sinusoïde de 4 volts crête à crête. 

Q4

vin

PS-1

R15R14RV3

R11

R13

R12

R16

C1

C2

Canal 2

Canal 1

 
Figure 2. 3 
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R14 = 4,7 kW R15 = 680 W

 
Figure 2. 4 
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 Gain en tension Gain en courant Gain en puissance 

RC = 4,7 kW vout 
vin 
av 

ic 
ib 

b 

 

RC = 680 W vout 
vin 
av 

ic 
ib 

b 

 

Tableau 2. 1 
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·  Reconnectez C2 et R14 et déconnectez temporairement le générateur de signaux. 
Ajustez RV3 pour obtenir VCE = 8 volts. 

·  Brancher à nouveau le générateur et observer le signal de sortie. 
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Figure 2. 5 
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·  Déconnectez temporairement le générateur de signaux et ajuster RV3 pour obtenir 
VCE = 2,5 volts avec R14 (court-circuiter R11 si vous n’arrivez pas à atteindre cette 
valeur). 

·  Branchez à nouveau le générateur et observez le signal de sortie. 
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Figure 2. 6 
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4.3 Réponse fréquentielle 

·  Utilisez le même circuit et les mêmes connexions que ci-dessus (figure 2.2). Vérifiez 
que PS-1 est toujours à 10 volts et modifiez RV3 pour obtenir VCE = 5 volts. 

·  Réglez le générateur de signaux pour obtenir en sortie une sinusoïde 6 volts crête à 
crête, 1000 Hz (Vérifiez avec l’oscilloscope). 
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vin crête à crête observé = 

Fréquence (Hz) 100 500 1K 5K 10K 20K 50K 100K 

vout (p - p)         

Gain en tension         

Tableau 2. 2 
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·  Déconnectez C2 et réglez le générateur de signaux pour obtenir en sortie une 
sinusoïde 3 volts crête à crête, 1000 Hz. 
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vin crête à crête observé = 

Fréquence (Hz) 100 500 1K 5K 10K 20K 50K 100K 

vout (p - p)         

Gain en tension         

Tableau 2. 3 
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4.4 Résistance de sortie 
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5 Le collecteur commun et le push -pull 

5.1 Collecteur - commun 

·  Localisez le circuit qui contient Q2. 

Q2 

R10 C3 

Canal 2 
Canal 1 

R8 

R9 

v in 

PS-1 

 
Figure 2. 7 

·  Ajustez PS-1 à 5 volts et générez une onde triangulaire 6 volts crête à crête, 2 kHz. 
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Figure 2. 8 
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Figure 2. 9 
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5.2 Le push - pull 

·  Connectez Q2 et Q3 selon la figure 2.9. 

Q2

R10 C3

Canal 2

Canal 1

R8

R9

Q3

PS-2

PS-1

R17

vin

 
Figure 2. 10 

·  Ajustez PS-1 à 10 volts et PS-2 à -10 volts. 
·  Réglez le générateur pour qu’il délivre une onde triangulaire 6 volts crête à crête, 

2kHz. 
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Figure 2. 11 
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Figure 2. 12 
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 LABORATOIRE III 

1 Matière à revoir 

·  Diodes, polarisation, modèle petit signal. (Cours chaps 2,4 et 5, répétitions 1 à 6) 
·  Utilisation de PSpice (ci-dessous). PSpice Student est téléchargeable à l'adresse 

suivante : http://www.montefiore.ulg.ac.be/~senny/download/91pspstu.exe. Il pèse 
près de 28 Mb. Attention, installer Schematics ! 

2 Préparation du labo 

·  Il vous est demandé en préparation d'établir et de résoudre la polarisation et le modèle 
petit signal du premier circuit utilisé dans ce laboratoire. On vous demande donc de 
déterminer les courants et tensions en tout point du circuit, ainsi que Ri, Ro et Av. Les 
fréquences de coupure théoriques du premier système (BJT) vous seront données, 
toutefois, leur calcul sera un bon exercice de synthèse à réaliser en préparation à 
l'examen. Laissez b sous la forme littérale, vous déterminerez cette valeur durant le 
laboratoire. Vous devez donc obtenir lors de votre préparation des expressions et non 
des valeurs numériques. 

·  Trois points seront accordés à cette préparation. 

3 Utilisation de Schematics et de PSpice 

3.1 Dessiner le circuit : 

·  Pour sélectionner les composants du cicuit : Draw-> Get New Part 
·  Pour connecter les composants entre eux : Draw -> Wire (ou icône) 
·  Pour mettre un composant dans la bonne orientation : Edit ->Rotate (ou ctrl+R) 
·  Pour changer les caractéristiques d’un composant : cliquer sur le composant. Attention 

aux unités : 1M sera compris comme un milli car Pspice ne tient pas compte de la 
casse. Utiliser 1 meg. Pour exprimer des micros, utiliser u. 

·  Pour indiquer les grandeurs que l’on veut visualiser dans probe : Markers -> ... 

3.2 Analyser le circuit : 

Analyse continue 

Analysis -> Setup -> DC Sweep 
Sélectionner le type de variable de votre analyse, entrer son nom, l’intervalle de variation 
(mentionner les valeurs des extrémités de l’intervalle et le pas) ainsi que le type de variation 
(linéaire, ...). 
Pour faire varier simultanément deux paramètres, choisir Nested Sweep , compléter la boîte de 
dialogue avec les informations nécessaires, et cocher la case Enable Nested Sweep . 
OK, Close. 

Analyse temporelle 

Analysis -> Setup -> Transient  
Choisir la précision du tracé et la durée de l’analyse. 
OK, Close 



C5CD���<�-�!�
�����
��
������*
��
�-�D��
��	
���>�� ���
�
�-�4;�
� ����
����
 � ����,�
������  

Analyse fréquentielle 

Analysis -> Setup -> AC Sweep 
Choisir le type de variation de la fréquence (linéaire, ...), l’intervalle sur lequel va se faire 
l’analyse et le nombre de points sur le tracé. 
OK, Close 

Analyse du circuit en fonction d'un paramètre. 

Pour analyser le circuit en balayant les valeurs d'un paramètre. Cliquer sur la valeur du 
composant que vous souhaitez faire varier pour faire apparaître la boite de dialogue "Set 
attribute value" et entrer {RVAL} (avec les accolades) à la place de la valeur (ex : 2meg).  

Ensuite définir les paramètres du circuits : Draw->Get new part->Librairies-> special.slb 
->Param ->Ok->Place and close. Cliquer sur PARAMETERS pour afficher la boite de 
dialogue. Entrer RVAL sans accolades dans NAME1 et entrer la valeur servant à l'analyse de 
point de polarisation (bias point detail), ici 2 meg dans value1. 
Pour finir analysis->setup->DC Sweep. Entrer les valeurs du paramètre entre lesquelles le 
circuit doit être analysé. Ne jamais passer par 0. OK->Close. 

3.3 



C5CD���<�-�!�
�����
��
������*
��
�-�D��
��	
���>�� ���
�
�-����
� ����
����
 � ����,�
������  

Simuler le circuit : 

Analysis -> Simulate  (ou icône) 

3.4 Visualiser les résultats : 

·  Pour examiner les caractéristiques du circuit : analysis -> examine output 
·  Pour tracer des graphiques : utiliser « Probe ».  

Dans probe :  
·  pour changer la variable en abscisse : Plot -> X Axis Settings -> Axis Variable 
·  Pour ajouter une variable en ordonnée : Trace -> Add 
·  Pour ajouter un  axe d’ordonnée : Plot -> Add Y Axis  suivi de Trace -> Add 
·  Pour choisir une analyse : Plot -> ... 
·  Pour connaître les coordonnées exactes d’un point du graphe : Tools -> Cursor 

        -> Display 
·  Pour sauver un graphique : Tools -> Display Control 



C5CD���<�-�!�
�����
��
������*
��
�-�D��
��	
���>�� ���
�
�-��@�
� ����
����
 � ����,�
������  

4 Application avec un BJT 

 
Figure 3. 1 
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IB = 
IC = 
VBE = 

VBC = 
VCE = 
BETADC = 

RPI = 
RX = 
CBE = 

CBC = 
BETAAC = 
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5 Redresseur double alternance en pont 

Le redresseur double alternance en pont du circuit suivant est suivi d'un filtre de régulation à 
condensateur et d'une diode Zener servant à réduire la tension d'ondulation et à réguler la 
tension de sortie à 10V. 

 
Figure 3. 2 

Vous utiliserez Spice pour déterminer l'amplitude de la tension d'ondulation à la charge 
représentée ici par un courant de charge de 25 mA. 
Pour cette simulation, le modèle de la diode D1N750 utilisé par Spice devra être simplifié et 
modifié afin d'utiliser les paramètres par défaut du modèle D de la diode et uniquement fixer 
BV (reverse bias breakdown voltage, fixé dans le modèle par défaut à l'infini) à 10 V et IBV 
(reverse bias breakdown current, fixé dans le modèle par défaut à 1.10-10 A) à 1mA. 
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Vous devrez remplacer les paramètres spécifiques à la diode 1N750 par : 
.model D1N750-X D(  
Bv=10 
Ibv=1m )  
 
Remarque : à l'aide du circuit suivant et d'une simulation DC Sweep, il est possible d'obtenir 
la courbe caractéristique suivante pour le modèle et les paramètres choisis. Cette courbe ne 
doit pas être obtenue au laboratoire, mais constitue un bon exercice supplémentaire. 
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V in, VC1, VD5 
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6 Circuit démodulateur AM 

Soit le signal vin(t)=vm(t) sin(2 p fc t) 
 

avec fc = 1/Tc =1 MHz et vm(t) une onde triangulaire qui varie lentement (1/Tm = 100 Hz). Ce 
signal est représentatif d’une onde modulée en amplitude (modulation AM). L’onde porteuse 
est sin(2 p fc t), le signal utile est contenu dans vm(t) (de la musique par exemple). 
 
Montrez que le circuit ci-dessous, appelé « démodulateur AM », extrait la tension vm(t) si la 
constante RC est choisie de façon adéquate. Précisez comment choisir RC. 
 

 
Figure 3. 3 

Pour simuler le signal modulé, nous allons utiliser le composant EMULT permettant d'obtenir 
une tension de sortie (OUT, Fig. 3.6) correspondant au produit de deux tensions d'entrée de 
référence (IN1 et IN2). Ce composant nous permet donc de construire le signal modulé vin(t). 
L'onde porteuse sera simulée par une source Vsin et l'onde triangulaire par un source Vpwl 
(Fig. 3.5). Les paramètres des deux sources sont repris sur le schéma. 
 
Il est possible de montrer qu'il faut vérifier Tc << RC << Tm pour obtenir une bonne 
démodulation. RC = 5 ms est une valeur centrale de cet intervalle. 
 

 
Figure 3. 4 
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Figure 3. 5 : V2 

 
Figure 3. 6 : EMULT OUT 
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VEMULT-OUT, VR1|C=0.1µF, VR1|C=0.5µF, VR1|C=2.5µF 
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Annexe 1 :Manuel d’utilisation des stations EB-2000 
Remarque : le présent texte traitant des stations EB-2000 a été tiré des notes de labos du cours d’« Électronique générale ». 

6.2 Description générale 

Les laboratoires sur l’EB-2000 sont structurés autour de : 

·  Une station appelée Master Board 
·  Une série de cartes appelées PCB (Printed Circuits Board) 

Chaque carte permet de réaliser un certain nombre d’expériences prédéfinies, relatives à un 
domaine spécifique de l’électronique (microprocesseurs, électronique digitale, électronique 
analogique, électronique de puissance,… ) 

6.3 Initialisation de la station 

Vous trouverez sur chaque carte le domaine d’application ainsi qu’un numéro EB-***. Dans 
le coin supérieur droit de la carte se trouve un code de 6 chiffres qu’il faut fournir à la station 
pour qu’elle reconnaisse la carte. Ceci se fait à l’initialisation, la reconnaissance étant 
confirmée par l’affichage du numéro de la carte (EB-***). 

6.4 Les modes de fonctionnement 

Le système propose 4 modes de fonctionnement. 
·  Mode 1 ou mode Expérimentation. 

Toutes les expériences ou mesures sont effectuées dans ce mode. 
·  Mode 2 ou mode Practice. 

Dans ce mode, la station, gérée par un microprocesseur, modifie la topologie du 
circuit que vous analysez. Moyennant une connaissance préalable du circuit, vous 
devez déterminer la faute introduite par le microprocesseur. Ce mode est activé par 
l’utilisateur. 

·  Mode 3 et 4. 
Ces deux derniers modes se basent sur le mode 2. La station génère des fautes dans 
tous les circuits de la plaque. Le mode 4 se différencie du mode 3 par l’introduction 
d’un chronomètre. 

La figure suivante décrit la routine d’initialisation. 

OPERATION AFFICHAGE REMARQUES 
 "pcb" pendant 2 sec puis "pcl"  

Introduire les 3 premiers 
chiffres du code de PCB 3 chiffres Vérifier et corriger si 

nécessaire 
* "pcb" pendant 2 sec puis "pc2" * = ENTER 

Introduire les 3 derniers 
chiffres du code de PCB 3 chiffres Vérifier et corriger si 

nécessaire 

* EB-*** 
*** = numéro du cours. 
Vérifiez que EB-*** est 
correcte (coin gauche) 

* id1 Numéro d'étudiant 
Entrer 0 

* id2 Entrer 0 
* id3 Entrer 0 
* FM Mode de fonctionnement 

Vous devez à ce stade choisir le mode de fonctionnement desire. Taper : 
"1" pour Experiments mode 
"2" pour Practice mode 
"3" pour Test mode 
"4" pour Troubleshooting Mode. 
FM1, FM2, FM3 ou FM4 s'affiche, valider par "*". 
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 Annexe 2 : 
Règlement d’ordre intérieur des laboratoires  

R100 et S125 
Dans ce qui suit, il est convenu que : 
 
Laboratoire signifie les laboratoires R100 et S125. 
Personne responsable du laboratoire, signifie, pour les cours correspondants : 
ELEN001, ELEN0075 S. De Grève ; ELEN032, ELEC032 S. Coets ; ELEN033, ELEN037 F. 
Senny ; ELEN040 F. Senny, S. De Grève ; INFO064 C. Burnotte. 
 
Petit matériel signifie le matériel nécessaire aux manipulations de laboratoire qui n’est pas 

présent à demeure sur les bancs de laboratoire. 
 
Article 1 :  Accessibilité 

Le laboratoire est accessible aux étudiants uniquement pour des activités 
liées aux enseignements précités, prioritairement dans le cadre d’un horaire 
pré-établi et secondairement en accès libre. 
Dans la mesure des disponibilités des personnes responsables, le laboratoire est 
ouvert en semaine de 8H30 à 17H00. 
 

Article 2 :  Matériel  
La fourniture du petit matériel se fait de 8h30 à 8h45 et de 14h à 14h15. En cas 
d’absence de la personne responsable ou en dehors de ces périodes, le petit 
matériel n’est pas accessible. 
La restitution du petit matériel doit se faire dans la journée de l’emprunt auprès 
de la personne responsable. 
En cas de non-retour du matériel ou en cas de perte, la valeur de remplacement 
du matériel non rendu sera réclamée à l’emprunteur.  
Il est recommandé de ne pas laisser le petit matériel sans surveillance. 
 

Article 3 :  Il est interdit de fumer, manger ou boire dans le laboratoire. 
  

Article 4 : Le matériel du laboratoire doit être traité avec soin. Toute détérioration ou 
défaut doit être immédiatement signalé à votre responsable. Aucun matériel ne 
peut être déplacé. 
 

Article 5 : Vos seuls interlocuteurs sont vos assistants et professeurs du cours concerné. 
L’accès au couloir prolongeant le local est interdit. 

 
Article 6 : Aucun logiciel ne peut être installé, personnalisé ou reconfiguré sur les 

machines présentes dans le local. Aucun branchement ne peut être modifié. 
L’accès à internet ne peut se faire qu’en utilisant les machines disponibles à cet 
effet. 
 

Article 7 : Avant de quitter le local, ranger le matériel utilisé, nettoyer les tables et 
éteindre tous les équipements utilisés. En particulier, veuillez éteindre 
l'alimentation principale de la table de laboratoire et les ordinateurs. 

 
Bon et fructueux travail ! 
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 Annexe 3 : Les résistances 
Les valeurs des résistances sont représentées à l’aide d’un code de couleur, composé de 
plusieurs bandes.On distingue des résistances avec 4, 5 ou 6 bandes de couleurs. 
Pour lire le code de couleur d’une résistance à 4 ou 5 bandes, on commence par tenir la 
résistance horizontalement devant soi en mettant le plus grand espace non marqué sur sa 
droite. 
Pour lire le code de couleur d’une résistance à 6 bandes, il faut la tenir comme représenté à la 
page suivante. 
La lecture du code couleur se fait comme représenté sur les figures suivantes : 
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 valeur  multiplicateur tolérance coeff. de t° 
(rien)   ± 20%  

argent  x 0,01 ± 10%  
or  x 0,1 ± 5 %  
noir 0 x 1  200 10-6 

brun 1 x 110 ± 1 % 100 10-6 
Rouge 2 x 100 ± 1 % 50 10-6 
Orange 3 x 1 k  15 10-6 
Jaune 4 x 10 k  25 10-6 
Vert 5 x 100 k ± 1 %  
Bleu 6 x 1 M ± 1 %  
Violet 7 x 10 M ± 1 %  
Gris 8    
Blanc 9    

Astuce mnémotechnique pour retenir le code couleur : 

 Ne Mangez Rien Ou Je Vous Battrai V iolemment Gros Béta 
 Ne Mangez Rien Ou Je Vous Brûle Votre Grosse Barbe 
 Ne Mangez Rien  Ou Jeûnez Voilà Bien Votre Grande Bêtise 
 
 Noir Marron Rouge Orange Jaune Vert Bleu V iolet Gris Blanc 
 0 1 2 3 4 5 6 7 8 9 
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 Annexe 4 : Agir en cas d’urgence 

 


